Productivity Tools Options Setting Productivity Tools Options

Productivity Tools Options

TaiRox Productivity Tools Options lets you hide productivity tools that are not used by your company and
set a wide variety of options for entering orders, shipments, purchase orders, and PO receipts.

Important Notes: The Options program is only available to the Sage 300 ADMIN user. Changes are
site-wide, meaning that they apply to all Sage 300 companies, even though the edits are done while
logged into a single company’s desktop.

Setting Productivity Tools Options

Choose the Options program from the top-level of the Productivity Tools menu:

~ TaiRox Productivity Tools ~
Accounts Payable Tools TaiRox Productivity Tools (General Ledger Tools)
ASCoUERECSRbISCER) Licensed to: Don Thomson, TAIROX SOFTWARE INC
Administrative Services Tools Dealer: TaiRox Software, Inc
General Ledger Tools cc Don
Inventary Control Tools
Mutti-Company Tools
Order Entry Tools
S Genersl Ledger Tools  Order Entry Tools  Purchase Order Tools  Inventory Control  Accounts Receivable  Accounts Payable
ayrofl fools Tools Tools Tools
Purchase Order Tools
> US Payroll -— -— B
~ Visual Process & & &
fsualFrocess Hows Payroll Tools  Multi-Company Tools  License Information Options Convert Contacts  Administrative
A/P Transactions " Services Tocls
Sage | For Help, press Fi %] Session Date: 2024-03-25

The Productivity Tools Option screen displays five or six tabs, depending on your version of TaiRox
Productivity Tools.

Note that the General Ledger tab will not appear unless you have an Enterprise License for TaiRox
Productivity Tools. The General Ledger tab lets you specify an optional field for tagging posted G/L
transactions.

I Menu  fem Quartites Business Days  Order Entry  Purchase Orders IGenera\ Ledger I

¢ Menu tab: Lets you hide productivity tools that are not used by your company.

e Item Quantities tab: Lets you choose which locations and Sage 300 companies are included
when you view item quantities in Extended PO Entry, Extended PO Receipt Entry, Extended
Order Entry, and Extended Shipment Entry.

e Business Days tab: Lets you specify your company’s regular business days and additional non-
business days — such as statutory holidays and closures for inventory counts.

Productivity Tools uses the regular business days and non-business days to calculate Order
Entry’s expected ship date and deliver by date in the Extended Order Entry program. You set the
number of business days for the ship date and deliver by date on the Order Entry tab.

e Order Entry tab: Lets you display customer optional fields on the Order Entry and Shipment
Entry screens, require orders and shipments to include a purchase order number, warn for
customer PO numbers that were used on previous orders or shipments, show totals for a
selected unit of measure, include line discounts in margin and markup calculations, require a
valid ship-to location code, prevent users from changing the ship-to address on orders and
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shipments, calculate Order Entry’s deliver by date and expected ship date, and default the
guantity committed to the quantity ordered in Extended Order Entry for select customers.

e Purchase Orders tab: Lets you display vendor optional fields on the PO Entry and Receipt
Entry screens and require receipts to include a purchase order number. It also lets you link PO
lines created from an order to the original order lines — for use with reports or program additions —
and show totals for a selected unit of measure.

e General Ledger tab: Lets you specify an optional field for tagging posted G/L transactions. Note
that this tab will not appear unless you have an Enterprise License for TaiRox Productivity Tools.

Menu tab — select which Productivity Tools appear on the Sage 300 Desktop
A Productivity Tools activation code (all modules) provides access to dozens of tools.

Although single module activations are available for TaiRox Productivity Tools, the Options program
provides a quick way to hide tools that are not used by individual clients.

e |t allows customers to hide tools they are not using.

e |t allows resellers to demonstrate limited or full functionality quickly, without changing activations.

The Menu tab shows all TaiRox Productivity Tools — irrespective of the activation code in use. (The
General Ledger tab appears only if you have an Enterprise license for Productivity Tools.)

SAMLTD - Options

File  Help
Menu  lem Quatiies Business Days Order Entry Purchase Orders
][] TaiRox Productivity Tools -
-] General Ledger Tools
X/L Extended G/L Accounts

%/L Extended G/L Segment Codes
- [W] %/L Extended G/L Account Groups

<o [#] %/L Accounting Status Check all programs that
- [] %/L Extended Create New Year should appear on the
- [w] %/L Extended Fiscal Calendar Sage 300 Desktop.

- [w] ¥/L Set Recuming Dates

- [if] ®/L Copy G/L Accounts

-« [wf] /L Copy G/L Accourts Setup
- [if] ®/L Look Up G/L Account

%/L Tag Posted G/L Transactions
(- [] Order Entry Tools

- [W] %/L Extended Order Entry

- [i#] %/L Extended Shipment Ertry
- [w#] %/L Extended O/E Invoice Entry
<[] ¥/L Extended CR/DR Note Entry
<[] %/L Ship Orders

e To hidetools, deselect tools that you want to remove from the Sage Desktop.

For example, if Set Recurring Dates is not checked, it will not appear on users’ desktops.

Item Quantities tab — select companies and locations for ltem Quantities display

Productivity Tools lets you display item quantities from multiple locations while entering orders,
shipments, POs, and PO receipts. The multiple locations can be in the any Sage 300 Company.

e |n Options, click the Item Quantities tab to specify companies and locations to be displayed.

SAMLTD - Options

File Help

Menu  tem Quartities  Business Days Order Entry  Purchase Orders  General Ledger
Database ID | Description User ID Password Location Test Connection
SAMINC Sample Company Inc sa pass1234 1 Move Up
SAMINC Sample Company Inc sa pass1234 2
SAMINC Sample Company Inc sa pass1234 3 Move Down
SAMINC Sample Company Inc sa pass1234 4
SAMLTD Sample Company Limited sa pass1234 1
SAMING Sample Company L?mrted sa pass1234 2
SAMLTD Sample Company L!mrted sa pass1234 3
TSTLTD Sample Company Limited sa pass1234 4

TaiRox Productivity Tools for Sage 300 2

© 2009-2024 TaiRox Software Inc. All rights reserved.



Productivity Tools Options Setting Productivity Tools Options

e Use the Insert and Delete keys to add or remove locations and companies from the Item
Quantities grid and to change the order that locations appear.

e Note that access to the data is through SQL Server, so you must provide database credentials.
For Sage 2023 PU2 and higher: Item data will NOT appear unless the user ID and password
have sufficient permissions to access the Sage 300 Vault database as well as the individual
company DBs.

To display Item Quantities for Extended PO Entry and Extended Order Entry

e Select the Extended Order Entry > File > Settings menu choice to change the Item Quantities
display settings for sales orders.

e Select the Extended Shipment Entry > File > Settings menu choice to change the Item
Quantities display settings for OE shipments.

e Select the Extended PO Entry > File > Settings menu choice to change the Item Quantities
display settings for purchase orders.

e Select the Extended PO Receipt Entry > File > Settings menu choice to change the Item
Quantities display settings for purchase order receipts.

To customize the item quantities grid to suit user needs

Each user can customize the item quantities grid by hiding and moving columns to suit their own needs.
For example:
e You can hide the Database ID and Name columns if all locations are in the same Sage company.

e You can also hide the Item Description and Stocking Unit if these are the same at all locations.
Hide and re-arrange columns by dragging and dropping.

You could also hide the item number column.

PTDEMO - Item Quantities
Eile  Help

Location | Description Qty. On Hand | Gty. On Hand (All)

2 Portland Office A1-105/0 a

3 Newark, New Je..  A1-105/0 75 378 150 (1] 75 o 75
4 a

.

Port of Vancouver  A1-105/0 90 378 250 0 90
m b

e

Business Days tab — specify your company’s regular business days and
additional non-business days

TaiRox Productivity Tools uses the regular business days and non-business days to calculate Order
Entry’s deliver by date and expected ship date on the order screen in Extended Order Entry — and to
calculate the expected ship date on the Extended Shipment Entry screen.

SAMLTD - Options

Eile  Help

Menu  ftem Quantties  Business Days  Order Entry Purchase Orders  General Ledger

Business Days
[ Sunday Monday Tuesday Wednesday
Thursday Friday [ saturday
Non-Business Days Optional Feld MONBLSDAYS f'\

(The General Ledger tab appears only if you have an Enterprise license for Productivity Tools.)

You must also specify the number of business days after the order date to set the expected shipment
date and the deliver by date. You do this on the Order Entry tab on the Options form.

TaiRox Productivity Tools for Sage 300 3
© 2009-2024 TaiRox Software Inc. All rights reserved.



Productivity Tools Options

Setting Productivity Tools Options

To specify your company’s business days

Select the normal business days of the week for your company.

Business Days
[ Sunday Monday Tuesday Wednesday
Thursday Friday [ Saturday

The business days, along with days added to the non-business days optional field, are used to
calculate the shipment date and deliver by date in Extended Order Entry and the shipment date in
Extended Shipment Entry.

You must also set the number of days after the order date for the shipment date and deliver by
date on the Order Entry tab of the Options form.

Select the Non-Business Days optional field for your company

Select the optional field for listing non-business days for your company.

NONBUSDAYS Q I

Non-business days could include statutory holidays and any other days that your company is
closed — such as for quarterly stock taking. If the Optional Field is blank, the program will only use
the Business Days.

MNon-Business Days Optional Field

The non-business days optional field must by of type “date” — like the following example:

B SAMLTD - Optional Fields

File  Help

Optional Field
Type

Validate

Values

|4 4 [NONBUSDAYS P Pl S +  Descrption

Date
Allow Blank

Description

Canada Day
Labour Day
Thanksgiving Day
Chrismas Day
New Years Day

Save

Delete

Close

Note: The Extended Order Entry program will display warning messages on startup for a number

of possible error conditions. For example, the program will display the following message if the
non-business days optional field does not contain any future non-business days.

Waming
Description: There are no Non Business Days defined for Cptional Field

DARTDATE beyond 2024-03-25.
Source: 13:46:54 -

Messages will warn you for the following conditions:

o The Optional Field xxx used to define Non-Business Days does not exist in TaiRox

Productivity Tools Options.

o The Optional Field xxx used to define Non-Business Days in TaiRox Productivity Tools

Options is not a Date Type field.

o There are no Non-Business Days defined for Optional Field xxx beyond <today’s date>.
o There are no Business Days set in TaiRox Productivity Tools Options.

o You must set at least one Business Day.

TaiRox Productivity Tools for Sage 300
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Order Entry tab —require POs on orders and shipments, warn for duplicate PO
numbers on orders and shipments, show UOM totals, include discount % in
margin/markup, enforce ship-to location codes, prevent changes to ship-to
addresses, calculate expected shipment date and deliver by date, display
customer optional fields, and default the quantity committed to the quantity
ordered in Extended Order Entry for select customers

The options on the Order Entry tab let you:

Require orders and shipments to include purchase order numbers.
Warn if a PO is duplicated on an order or shipment.
Show unit of measure totals on the Extended Order Entry and Extended Shipment Entry screens.

Include the discount percent set on order lines the margin/markup calculations for each line and
for the order as a whole.

Prevent orders and one-time shipments (shipments without an order) from being posted if the
Ship-To Location is blank.

Prevent users from entering or changing ship-to addresses.

Calculate the expected ship date and deliver by date in Extended Order Entry and the expected
ship date in Extended Shipment Entry.

Default the quantity committed to the quantity ordered in Extended Order Entry for select
customers.

Display customer optional fields on Extended Order Entry and Extended Shipment Entry screens.

Note that Sage 300 optional fields are sold and installed as a separate module. You must install
optional fields, set them up in Common Services, add them to customers in Accounts Receivable,
and then select them in Productivity Tools Options to add them to the Extended Order Entry and
Extended Shipment Entry screens.

SAMINC - Options

File  Help

Menu  ftem Quantiies Business Days Order Entry  Purchase Orders  General Ledger

[/ Order/Shipment Must Have a Purchase Order Number Customer Optional Field REGPONUM )]

Leave the Customer Optional Field blank if @ Purchase Order Number is required for all customers. Select a Yes/MNo Customer
Optional Field name to control this option by customer.

Digplay a waming if a Customer Purchase Order is used on more than one Order or Shipment

Show Totals for This Unit of Measure _

[+] Subtract Discount from Margin and Markup Calculations

[#] Ship-To Location Cannot be Blank

Do Mot Allow Ship-To Address to be Changed

Set Expected Shipment Date To Business Days After Order Date

1
4

Set Deliver By Date To Business Days After Order Date

Default Quantity Committed Based on a Customer Optional Field COMMITATY
Order/Shipment Customer Optional Fields To Digplay
" Include Requires PO Number on Orders [
Accounts Receivable Contact Tr Default QTY Committed to Q@ TY Orde
Lease Date SEms Customer Credit Waming T

Lease Expirv Date Maximum Order Amount
(The General Ledger tab appears only if you have an Enterprise license for Productivity Tools.)

To force orders and shipments in Order Entry to include a purchase order number

Select the checkbox for “Order/Shipment Must Have a Purchase Order Number.”
I Order/Shipment Must Have a Purchase Order Number Customer Optional Field )] I

Optionally, select a Yes/No customer optional field to specify which customers require purchase
orders numbers on all orders and shipments.

In this example, the customer optional field is called “REQPONUM — Order Requires PO
Number.” The field must be a “Yes/No” type field.

TaiRox Productivity Tools for Sage 300 5
© 2009-2024 TaiRox Software Inc. All rights reserved.



Productivity Tools Options Setting Productivity Tools Options

If you select the checkbox — and do not specify a customer optional field — the program will
require a purchase order number on all orders and shipments.

Note: If you specify a Yes/No optional field -- and a customer record does not include the optional
field — the program will not require a purchase order number when you create an order or shipment.

To warn users that a PO number has been used on a previous order or shipment

e Select the checkbox for “Display a warning if a Customer Purchase Order is used on more than
one Order or Shipment.”

I Display a waming if a Customer Purchase Order is used on more than one Order or Shipment I

The program will warn users during Order Entry or Shipment Entry (where no order was entered)
if a customer purchase order has been used on a previous order or standalone shipment.

To show totals for a particular unit of measure on Extended Order Entry and Extended
Shipment Entry screens

e Select the unit of measure that you want to total. You can set the field to blank to turn off the
option.

I Show Totals for This Unit of Measure |EEI. | "._; I

The unit of measure will be totalled on the Extended Order Entry screen.

Q tem Mo./ Misc. Charge Description Q Price List | Q Location | Deliver By Exp. Ship Date | Gty. Ordered | Q, Order UOM

Double Pedestal 71in X 35n UK 2 20210413 20210413
A2(MAGE-1500G |2 [image 1500 Seriss Desk Acces [UK_ |1 | 20210413

P
A1-752/B Letter Tray - Kings-5000 Series UK 1 20210413 2021-04-13

I Total Ea \ 57|

Note that the total includes “Ea” unit of measure only. The “Pkg” unit is not included.

To include the discount set on order lines in margin/markup calculations
e Select the option to “Subtract Discount from Margin and Markup Calculations”.

I [+] Subtract Discount from Margin and Markup Calulations I

This option subtracts any line discount from the margin and markup calculations in Extended
Order Entry, Extended Shipment Entry, and Extend O/E Invoice Entry.

The margin and markup columns appear in the grid for each order, shipment, and invoice line.

Description Orig. Order Margin Percent Markup Percent Margin Amount | Most Recent Unit C... [l

Cross-Country Tr 0 4918109
ccT Cross-Country Tr... 2 2 49.11915 96.53762 130,63 135312520
ccT Cross-Country Tr 4 4 6294732 169.88604 22988 135312667
ccT Cross-Country Tr 3 5 49.11824 96.53407 10450 109.498000

If you click the Order Margin, Shipment Margin button or Invoice Margin button, the program will
include the discounts from each line in the margin and markup calculations.

Eile Help

e e
Merkup Percent
TaiRox Productivity Tools for Sage 300 6
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To prevent users from posting orders or shipments with blank ship-to locations
e Select the option to “Ship-To Location Cannot be Blank”.

I Ship-To Location Cannat be Blank I

The program will display the following message if users try to post an order or shipment without a

ship-to location code.

Error
Description: Ship-To Location Code cannot be blank

Source: 09:41:11-

To prevent users from entering or changing ship-to addresses
e Select the option to “Do Not Allow Ship-To Address to be Changed”.

I Do Mot Allow Ship-To Address to be Changed I

The program pop-up for ship-to addresses (shown below) will display the current address but not

allow changes:

Customer No. |1zou | |Mr. Ronald Black ‘

Ship-To Name |Mr. Ronald Black |
Address |2azo Wabash Road |

To calculate Order Entry’s expected ship date and deliver by date

e Enter the number of business days following the order date for goods to be shipped and
delivered.

Set Bxpected Shipment Date To | 4] Business Days After Order Date
Set Deliver By Date Ta Business Days After Order Date

e Enter “0” to disable the options.

Order Entry uses the Business Days and the dates in the Non-Business Days optional field (specified
on the Business Days tab) to calculate the expected ship date and deliver by date in Extended Order

Entry, and the expected ship date in Extended Shipment Entry.

For example, if your company:

e Has a 5-day work week.
e And Monday is a holiday in the non-business days optional field.
e And orders are expected to ship 4 business days after the order date.

An order entered on Friday will display an expected ship date for the following Friday.

You can override the shipment date and the deliver by date for the order header and for individual
order detail lines in the Extended Order Entry program.

TaiRox Productivity Tools for Sage 300
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To default the quantity committed on orders to the quantity ordered for select customers

¢ In the “Default Quantity Committed Based on a Customer Optional Field,” select the Yes/No
customer optional field that will specify which customers have the quantity ordered automatically
entered in the quantity committed field.

Default Quantity Committed Based on a Customer Optional Field COMMITGTY )] I

In this example, the customer optional field is “COMMITQTY -- Default QTY Committed to QTY
Ordered.” The field must be a “Yes/No” type field.

Notes:

e If you specify a Yes/No optional field -- and a customer record does not include the optional field
— the program will not default the committed amount when you create an order.

e Sage 300 Order Entry Options includes an option to “Default Quantity Committed.”

® SAMINC - O/E Options

File  Help

Company | Processng  Documerts

Functional Currency

Processing Optians Sales History

Calculate Backorder Quantities Keep Sales History

Keep Transaction Histary Accumulate By Period Type

17| Mlow Non-existert Customers [Fiscal Year | [FscalPeiod |

Default Quantity Committed

If the ‘Default Quantity Committed’ is set in Order Entry Options that setting will take
precedence over the customer optional field specified here, and all customers will have the
committed quantity set to the ordered quantity.

Also, the Productivity Tools Options program will display the following warning message if you
choose the “Default Quantity Committed Based on Customer Optional Field” option in Productivity
Tools Options with the Order Entry “Default Quantity Committed” option chosen.

Waming

Description: The option to "Default Quantity Committed’ in Order Entry Options
is set and ovenides the option "Default Quantity Committed Based on &
Customer Optional Field'.

Source: 12:45:30 -

No warning will appear in Order Entry Options if you choose the “Default Quantity Committed”
option after choosing the Productivity Tools option to default the quantity committed. However,
this warning will appear when you open the Extended Order Entry program.

To add optional fields to the Extended Order Entry and Extended Shipment Entry screens

e Highlight the optional field you want to display in the list on left side, and click the Include button.

Crder/Shipment Customer Cptional Fields To Display

~ Include > Up

Accounts Receivable Contact Tr Default ATY Committed to QT Orde

Leaze Date Customer Credit Waming

Lease Expiry Date < Exclude Maximum Order Amount Down

Lease Perod Minimum Order Amourt

Note Al Discount Grace Period

Prefemed Customer Due Date Grace Period

PROSPECT <- None

Rental Customer 400

In this example, we’ve included the optional field “Requires Purchase Order Number” to remind
users that the program will use this field to force an entry in the PO No. field. We've also included
“Default QTY Committed to QTY Ordered” so users can see that quantities ordered are defaulted.

e You can use the Up and Down buttons to change the order that optional fields are displayed on
the Extended Order Entry and Extended Shipment Entry screens.

TaiRox Productivity Tools for Sage 300 8
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The following Extended Order Entry screen shows that a value has been set for the Requires
Purchase Order Number field and for the Default Quantity Committed field, so the program will force
you to enter a PO number and it will default the quantity committed based on the quantity ordered.

SAMINC - Extended Order Entry

Fle Help  O/E Order Entry

Orderbo. |4 4 P Qo+ No. of Shipments E Last Shipment No |:|
Ty e
“Order Customer Taxes Option Fikis  Sales Spit Totals :
T s 0} PO No. @a-ne-m ‘ ‘Sla\us | ‘EﬂlefedBy
Order Date Conkdd |
Eam T []From Mutiple Quotes ! [ 14ob Related T e T

Purchase Orders Entry tab — display vendor optional fields, require PO numbers
on PO Receipts, show UOM totals, and link PO lines back to the original order

The options on the Purchase Orders tab let you:
e Display vendor optional fields on Extended PO Entry and Extended PO Receipt Entry screens.
e Require PO receipts to include purchase order numbers.
e Link PO lines created from an O/E order to the original order lines.

Note that the link to the original order line uses the database line ID for the order line — not the
line number shown in the order Ul. The link can be used for customized/BI reports or program
additions.

e Show unit of measure totals on the Extended PO Entry screen.

= SAMLID - Options

File Help

Meru  tem Quantities  Business Days  Order Entry  Purchase Orders  General Ledger

Receipt Must Have a Purchase Order Number Vendor Optional Field RECREQFO by

Leave the Vendor Cptional Field blank if & Purchase Order Number is reguired for all vendor receipts. Select a Yes/MNo Vendor
Optional Field name to contral this option by vendors.

Optional Field for Linking PO Lines to Original O/E Order Line Numbers ORDERLINENUM b
Show Totals for This Unit of Measure 4

Purchase Order/Receipt Vendor Optional Fields To Display

Accounts Payable Contact Type E Include -> ’ ACH Up

Discount Grace Period Receipt requires PO number

\endor's Purchasing Representative Disc Level

Temporary Vendor < Exclude Due Date Grace Period Down

UPS Zone Note

Vendor Class Al->

(The General Ledger tab appears only if you have an Enterprise license for Productivity Tools.)

Note that Sage 300 optional fields are sold and installed as a separate module. You must install the
optional field module and set up optional fields in Common Services.

e You must add vendor optional fields to vendor records before you can add them to Extended PO
Entry and Extended PO Receipt Entry screens.

e To require PO numbers for particular vendors, you must add a Yes/No optional field in Common
services, add the field to vendors in Accounts Payable, and then select the field in Productivity
Tools Options.

e To add a link from PO detail lines to the original O/E order details, you must add an integer type
line number optional field in Common services, add the field to PO detail lines, and select the field
in Productivity Tools Options.

The optional field will be populated with the O/E line number when you create a PO in Order
Entry from order details using the “Create Purchase Order” button in Extended Order Entry.

TaiRox Productivity Tools for Sage 300 9
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To force receipts in Purchase Order Entry to include a purchase order number

e Select the checkbox for “Receipt Must Have a Purchase Order Number.”

I Receipt Must Have a Purchase Order Number Vendor Optional Field |REOP0 | "._" I

e Optionally, select a Yes/No vendor optional field to specify which vendors require purchase
orders numbers on all receipts.

In this example, the vendor optional field is called “Require PO Number on Receipts”. The field
must be a “Yes/No” type field.

If you select the checkbox — and do not specify a vendor optional field — the program will
require a purchase order number on all receipts.

Note: If you specify a Yes/No optional field -- and a vendor record does not include the optional field
— the program will not require a purchase order number when you create a receipt.

To link PO lines created from an O/E order to the original order lines

o Create a new integer optional field in Common Services and give it an appropriate name — in this
example, “ORDERLINENUM”.

B SAMLTD - Optional Fields

Eile  Help
Optional Field [CRE RORDERLINENLIN S A 3] Q +  Description PO field for original O/E line number ‘
e

Validate

e Add the integer optional field to purchase order details using the Optional Fields program in the
P/O Setup folder. Do not set a value for the field, make it required, or auto-insert it on details
lines.

B SAMLTD - P/O Optional Fields
File

Help

General

Optional Fields For Purchase Order Details ~ ‘

Q, Optional Field Optional Field Description Value Set | Q Default Value | Value Description | Required | Auto Insert [iel

PO field for onginal O/E lin..._

If you want the order line numbers to follow through to the receipt, invoice, CR/DR notes and
returns, you should also add it to the receipt details, invoice detals, return details, and cred/debit
details.

e When you create a PO in Order Entry from order details, make sure that you use the “Create
Purchase Order” button in Extended Order Entry (not the “Create PO” button).

Post Create PO Delete History Prepayment Create Purchase Order Order from History. O/ Foms Close
Database ID Location Desciption ftem Number Description Stocking Unit q
SAMING 3 Newark, New Je... A1757/G Paper Clip Dispe...  Ea. E] ] ] 7
SAMINC 4 Port of San Fan A1-757/G Paper Clip Dispe Ea 0 0 0 0 v

<

To show totals for a particular unit of measure on Extended PO Entry screens

e Select the unit of measure that you want to total. You can set the field to blank to turn off the
option.

I Show Taotals for This Unit of Measure "._\' I

The unit of measure will be totalled on the Extended PO Entry screen.

TaiRox Productivity Tools for Sage 300 10
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. | Completed | Q Hem Number ltem Description ] Drop-Ship Quantity Ordered | Q, Unit of Measure

1 No A1-105/0 13W Mini Fluorescent Bulb 1 No _’ 75 Ea

2 No A1-755/G Letter Tray - Image-1500 Series 1 No 50 Pkg

3lNo | AL105/0 13 Mini Fluorescent Bulb e e, SEllE

.
< >

Note that the total includes “Ea” unit of measure only. The “Pkg” unit is not included.

To add optional fields to the Extended PO Entry and Extended PO Receipt Entry screens

e Highlight the vendor optional field in the list on the left side that you want to display, and click the
Include button.

Purchase Order/Receipt Vendor Optional Fields To Display
Include -» Require PO Number on Receipts Up
Note

Vendor's Purchasing Representative

ACH
Accounts Payable Contact Type
Disc Level

Discount Grace Period CEmLE Vendor Class oy
Due Date Grace Period
TeminraE Vendar Al-»

<- None

In this example, we’ve included the optional field “Requires Purchase Order Number” to remind
users that the program will use this field to force an entry in the PO Number field on receipts.

e You can use the Up and Down buttons to change the order that optional fields are displayed on
the Extended PO Entry and Extended PO Receipt Entry screens.

The following Extended Order Entry screen shows that a “yes” value has been set for the Requires
Purchase Order Number field, so the program will force you to enter a PO number.

SAMLTD - Extended PO Receipt Entry

File Help  P/OReceipt Entry
Sl e D —
Vendor Mumber | [1200 | 1+ & |Ch|cride3yslems |

Recgift Taxes Addtional Costs Optionl Fields Rates Totals

Potumber | | |Q [FomMdiperos ) [lobRelated | |Retanage M. of Receipts Optional Feld
Receipt Date [2021-0419 Posting Date 20210419 2021-04 Last Receipt No. i 1
o fprzrass| : g T
Tempiate [ ]2 stfolocan [ |23 SipTolocaion | |3 B Vendor's Purchasing

Vendor Ciass Miscellanzous Expense P...
FOB Poirt [ | Shplia | Q]

General Ledger tab —tag posted G/L transactions — Enterprise feature only

The General Ledger tab lets you specify an optional field for tagging posted general ledger transactions
with the Tag Posted G/L Transactions Productivity Tool.

SAMLTD - Options

File  Help

Menu  ftem Quantities Business Days Order Entry Purchase Orders  General Ledger

Posted General Ledger Transaction Optional Field Tag  [TAGGL | J |TEQ General Ledger Tranaction Optional Field

Tag Posted G/L Transactions is a Productivity Tools Enterprise Program

Note that the General Ledger tab will not appear in Productivity Tools Options — and that the Tag
Posted G/L Transactions Tool will not appear in TaiRox Productivity Tools unless you have a
Productivity Tools Enterprise License.

TaiRox Productivity Tools for Sage 300 11
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To set up an optional field for tagging posted transactions

e First, create the optional field in Common Services that you want to use for the tag.
In this example, the new optional field is called “TAGGL — Tag General Ledger Transaction

Optional Field.”
The field is a text field — length 60 characters.
This example provides four tag values.

I SAMLTD - Optional Fields

File  Help

Values

Description

Tag1 description

Optional Field |4 4 |TAGGL b pl Q +  Description |Tag General Ledger Tranaction Optional Field
Type o
Validate

Tag 2 description
TAG3 Tag 3 description
TAG4 Tag 4 description
v
Save Delete Close

o Next, add the tag to General Ledger Transaction Details using the G/L Optional Fields Setup

program.
B SAMLTD - G/L Optional Fields
File  Help
Optional Fields For |Tran5actinn Details v|

Q, Optional Field Optional Field Description Value Set &
APPROVED Approved Yes
FRGHTMETHOD Freight Method Tes
LEASEEXFIRY Lease Expiry Date Yes
PACKER Packer Yes
QUANTITY Quantity Yes
SALESREP Sales Rep Yes
SQUAREFT Square Footage Yes
Tag General Ledger Tranaction Optional Field N0 | | |
LIOM Lom Yes
LSER User Yes
WARRANTYFRD Warranty Period Yes

o Finally, specify the optional field for posted G/L transactions in the Productivity Options program.

SAMLTD - Options

File Help

Menu  tem Quantities Business Days  Order Entry  Purchase Orders  General Ledger

TAGGL | ‘ |Tag General Ledger Tranaction Optional Field

Posted General Ledger Transaction Optional Field Tag

Setting up security groups for users to tag posted transactions

If you use Sage 300 security features, you must also ensure that users have rights to Tag Posted G/L
Transactions and sufficient G/L rights to tag transactions and look up transaction tags.

TaiRox Productivity Tools for Sage 300
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In order to use the Tag Posted G/L Transactions Productivity Tool, you need security access to the
program in the TaiRox Productivity Tools Security Group.

M SAMLTD - Security Groups

File  Help

Application TaiRox Productivity Tools 6.14 w
Group 1D |4 o [FULL PO+
Group Description |Fu|| Accessto TPT

Select to grant security access

Look Up G/L Accounts ~
Application Security

Create Price List

Extended O/E Invoice Entry

Remove ltems from Price Lists

[wl Customer Backorders

[v] Update Cuslurnars

[v] Tag Posted G/L Transactions

Save Delete Select All Remave All Close

In order to tag a posted transaction, you need General Ledger Transaction Maintenance security
access.

To inquire on / export G/L tags, you must have History/Budget Inquiry security access or History/Budget
Maintenance security access.

M SAMLTD - Security Groups

File  Help

Application General Ledger 7.1A w
Group ID |4 o [2UH e
Group Description |FI-I|| Access

Select to grant security access

[l Common Inquiry A
. W] Account Malntenance

— Required to tag/edit

-@— Either to inquire/export

Save Delete Select Al Bemove Al Close

For more information on tagging G/L posted transactions, see the User Guide for the Tag Posted G/L
Transactions Tool.
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